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1. Introduction 

Customer care has become the most influential factor for the success of any service provider.  To 
provide higher levels of customer satisfaction, providers need to provide customer support via 
widely accessible methods.  Media such as Web-based, self-service portals and automated call 
directing systems have joined conventional telephone call center personnel as ways to expand 
companiesô ability to assist their customers.  These media help companies to provide various 
services to customers such as provisioning, technical assistance, answers to billing questions 
and up-selling new products to existing customers. 

The Microsoft Customer Care Framework, CCF, helps companies in these important tasks by 
reducing the development and maintenance costs associated with contact center applications 
and self service portals.  CCF also helps with the smooth, easy integration of existing Line of 
Business (LOB) applications and improves operating efficiency. 

In CCF, the framework is separated from the Customer Service Representative using the 
Integrated Agent Desktop (IAD) and Customer Self Service Portal (CSSP).  However the IAD is 
the interface that the CSR, that is the Agent, uses to operate and communicate with CCF. 
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1.1 Document Conventions 

This documentation conforms to a set of conventions that attach specific meanings to typefaces 
used in explanations and procedures. 

Typeface Meaning 

Arial Bold  Used for control names, this is the text that actually appears on a 

button or selection.  

Example: At the bottom of the page, click Submit.   

Arial Italic  Used for emphasis, this is a word or phrase that is important in its 

context. 

Example: Make sure the checkbox is not checked.   

Arial Bold Italic  Inserted text, this represents what you actually type into the given 

space. 

Example: Type WebService in the text box. 

Courier multi - color  Used for code examples taken from Microsoft Visual Studio. 

Example: 

<! --  Customer Web Service Path -- > 

    <add  key =" CustomerWS"  

value =" http://CCFIIS/Microsoft.Ccf.Csp.Customer/C

ustomer.asmx " />  

<Arial Italic> Used to indicate a user-supplied value, the text in the carats is the 

name of the value.  It is italicized to differentiate from XML tags. 

Example: <drive>:\Program Files\Common Files\Microsoft Shared 

<drive> would indicate the drive letter where the files are stored. 

< Arial Bold > -> < Arial Bold > ->é This indicates a menu selection path.  Choose the first item, then 

the next sub item, and so on. 

Example: 

Tools -> Internet Options -> Security -> Local intranet -> Sites  
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2. Table of Terms and Substitutions 

Various terms are used to denote variables within this document.  For example, the domain 
controller is shown as the variable <DomainController>.  CCF represents the NetBIOS domain 
name, so the term CCF.demo is the fully-qualified domain name represented by the variable 
<CCFFQDN>.  The term CCFIIS represents the IIS server name and is also represented by the 
variable <IISSvr>, and so on.  

In the actual installation, wherever you see these names you can replace the variables with the 
actual names within your domain, for your own examples.  Wherever appropriate, the following 
terms, some mentioned above, will be used interchangeably in this document. 

Term Meaning 

<AgentDesktopInstallDir> C:\Program Files\Microsoft\Microsoft.Ccf.Samples.AgentDesktop 

(default, yours may be different) 

<AIFIIS> An IIS server where AIF is installed, may be shared. 

<AzManRoot> Location of AzManCCF.xml file  - C:\CCF\DemoData\ in this 

document. 

<CCFAdminAcct> CCF administratorôs account such as CCFAdmin 

<CCFAdminPW> The administrative password 

<CCFFQDN> Fully qualified domain name in the form machine.host.domain 

<CERTSvr> The server where Certification Authority is installed.  This may or may 

not be its own machine. 

<CMSWebServer> CMSWebServer 

<CSSPIIS> The Customer Self Service Portal IIS server.  CSSP can share the 

IIS server used for CCF. 

<CSSPMOSS> The Customer Self Service Portal MOSS server 

<cssWebServer> Customer self-service web server 

<CTIServer> Server where CTI services are installed 

<DomainController> The domain controller for CCF 

<DomainName> The CCF domain name 

<DNSSvr> The DNS server that CCF uses 

<IISSvr> The IIS server that CCF uses 



 

Microsoft Customer Care Framework 2008 -- Development Guide 
13 

<InstallDir> The directory into which you unpacked the files from the CD.  This 

folder must be in the root directory such as: C:\CCF. 

<LOBSvr> The line of business application server.  This can be any machine 

running IIS except <CCFIIS>, <AIFIIS>. 

<machineName> The name of the machine in question. 

<OSDrive> The drive on which the OS is installed (for example: C:) 

<port> Specific port for a Web application 

<ReportSvr> The SQL report server ï CCFRS 

<SQLSvr> The SQL server that CCF uses L 

<SSPCIIS> The IIS machine where SSPC components are installed. 

<wwwrootDir> C:\InetPub\wwwroot (default, yours may be different) 
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3. Integrated Agent Desktop 

This feature includes the server and client components of the Integrated Agent Desktop (IAD) and 
the CCF Administrative tool.  The following sections describe, in detail, the configuration, and 
customization of Agent Desktop and Admin Console. 

3.1 Configuring the Development Environment 

3.1.1 Prerequisite Software 

The machine must have the following software installed to setup the development environment 
for Customer Service Representation (CSR) Applications: 

¶ Windows 2003 Server (or) Windows XP Professional. 

¶ Microsoft .NET Framework 3.0 available from Microsoft 

¶ IIS 6.0. 

¶ SQL Server 2005 SP1 

¶ SQL Reporting Services 

¶ Visual Studio 2005. 

¶ Windows Workflow Foundation Extensions for Visual Studio 2005 available from Microsoft.  

¶ If you intend to use to the Logging.Providers.Eif project, install the Enterprise 
Instrumentation Framework (EIF).  EIF is available from Microsoft.  If you are not using this 
provider, you do not need EIF.  

¶ Install Authorization Manager Tools if developing on Windows XP.  These can be 
downloaded from the Microsoft site. 

¶ Microsoft Enterprise Single Sign On (SSO) is part of Microsoft BizTalk Server 2006 and Host 
Integration Server.  If you have one those products you need not install the SSO version 
supplied with CCF. 

¶ Latest Windows Update 

Note: When attempting to open the Agent Desktop solution in Visual Studio 2005, for 

example to reconfigure the Desktop, the Customer WS project may throw the following 

error:  

The project 

fileôC:\ccf\SourceCode\Microsoft.Ccf\Csr\WebServices\Customer\Microsoft.Ccf.Csr.Webs

ervices.Customer.csprojô cannot be opened.  The project type is not supported by this 

installation. 

To allow Visual Studio to open the project, install the Visual Studio hotfix VS80-

KB915364-X86-ENU.exe from the Others folder in the CCF installation directory. 

For more information on this hotfix see the MSDN article at: 

http://www.microsoft.com/downloads/details.aspx?FamilyId=8B05EE00-9554-4733-8725-

3CA89DD9BFCA&displaylang=en 

http://www.microsoft.com/downloads/details.aspx?FamilyId=10CC340B-F857-4A14-83F5-25634C3BF043&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=5D61409E-1FA3-48CF-8023-E8F38E709BA6&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=80DF04BC-267D-4919-8BB4-1F84B7EB1368&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=c16ae515-c8f4-47ef-a1e4-a8dcbacff8e3&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=8B05EE00-9554-4733-8725-3CA89DD9BFCA&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=8B05EE00-9554-4733-8725-3CA89DD9BFCA&displaylang=en
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3.1.2 Admin/User Rights on the Agent Desktop 

Users, including CSR agents, that will run the Agent Desktop but do not have Administrator rights, 
must be configured to do so.   

Note: This procedure requires the installation of Service Pack 1 32-bit Support Tools.  

This download is available from Microsoft.  Failure to install the support tools will result in 

an unrecognized command error. 

To run this procedure the user must have Administrator rights.  The configuration steps are as 
follows: 

1 On the machine in question, open a command window as Administrator. 

2 Type in the following command and press Enter:  

httpcfg set urlacl /u http://+:1000/ /a D:(A;;GX;;;<SID>) 

<SID> is the security identifier of the user of the machine.  It can also be the SID of a group of 
users 

2.a To obtain the SID run the following command in the command window: 
whoami/user ï returns the SID of the current, logged in user 

whoami/group ï returns a list of the groups to which the user belongs along with their  
SIDs  

Below is an example of how the command appears in the command line: 

C: \ Program Files \ Support Tools> httpcfg s et urlacl /u http://+:1000/ /a 
D:(A;;GX;;;s - 1- 5- 21- 3811445897 - 853718750 - 2640504884 - 1107)  

HttpSetServiceConfiguration completed with 0.  

C: \ Program Files \ Support Tools>  

The Vista operating system does not support httpcfg.  The following command is needed to 
perform the configuration: 

At the command prompt, type the following command: 

netsh http add urlacl url=http://+:1000/ user=<machineName>\<UserName> 

The machineName is the name of the machine that is being configured and the UserName is the 
name of the user or the group for which the machine is being configured.  

More information regarding this is available in an article on the MSDN website.   

The command uses the Security Descriptor Definition Language (SSDL) for implementation.  For 
more information on SDDL see the MSDN article. 

http://www.microsoft.com/downloads/details.aspx?familyid=6EC50B78-8BE1-4E81-B3BE-4E7AC4F0912D&displaylang=en
http://msdn.microsoft.com/msdnmag/issues/06/11/SecurityBriefs/default.aspx?loc=null
http://msdn2.microsoft.com/en-us/library/ms794693.aspx
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3.1.3 Configuration Steps 

To configure the development environment for the CSR feature of CCF, follow the steps below: 

This example assumes that the CCF program files are installed in a folder named: 
CCF2008\Development 

1 Open the command prompt and run the vsvars32.bat from <Drive>\Program 
Files\Microsoft Visual Studio8\Common7\Tools to set up the command line build 
environment (or run the command prompt shortcut that installs with Visual Studio) 

2 If necessary, delete all project related files for both application and Web Services and 
corresponding virtual directories created for ContactCenter, CcfInfrastructure, 
AdminConsole, and AgentCredentials Projects. 

3 Create an Application Pool named CCFAppPool to run under the Network Service account 
on the IIS machine.  Make all CCF virtual directories run under the CCFAppPool 
Application Pool.  By installing the Webservice MSI, the following virtual directories will be 
installed: 

4 Right click on each virtual directory and select properties to ensure that the properties in 
the table for each virtual directory are enabled. 

 

Virtual directory Properties 

Microsoft.Ccf.Csr.WebServices.ContactCenter anonymous access, set to CcfAppPool 

Microsoft.Ccf.Csr.WebServices.CcfInfrastructure anonymous access, set to CcfAppPool 

Microsoft.Ccf.Csr.WebServices.AgentCredentials anonymous access, set to CcfAppPool 

Microsoft.Ccf.Csr.WebServices.AdminConsole anonymous access, set to CcfAppPool 

Microsoft.Ccf.WebServices.Gateway anonymous access, set to CcfAppPool 

(anonymous access maybe necessary 

depending on your particular situation) 

 

5 Add http://ccfiis to the trusted sites in the Internet Explorer.  This step is required only if you 
do not have access to a DNS server to create these entries.  When doing development 
without a DNS system, update the hostôs file to add entries for CCFIIS and CCFSQL to 
point to 127.0.0.1.  The hostôs file is at: <drive>\windows\system32\drivers\etc\. 

Note: If Authorization Manager is used on Windows XP, the AzMan reference points to 

c:\Windows\Microsoft.NET\AuthMan\Microsoft.Interop.Security.AzRoles.dll which can be 

found on Windows 2003 Server systems.  It is not normally found on Windows XP, but 

can be copied there from Windows 2003 Server for compiling purposes. 

6 Run BuildCCF.bat on the system with the SQL Server. 

7 Change the password for the ASPNET user of the machine.  Add ASPUSER into the 
IIS_WPG group by following the steps below. 

 

http://ccfiis/
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If the machine is not a domain controller: 

7.a Right-click My Computer on the Start menu or the desktop. 

7.b Select Manage. 

7.c Select Local Users and Groups under System Tools to display Users and Groups 
folders. 

7.d Double click Groups and open IIS_WPG. 

7.e Click Add and add <DomainName>\ASPUSER into IIS Worker Process Group. 

7.f Click OK. 

If the machine is a domain controller: 

7.a Click Start -> Administrative Tools  

7.b Double-click Active Directory Users and Computers 

7.c Right-click IIS_WPG and click Properties 

7.d Click the Members tab 

7.e Click Add and add <DomainName>\ASPUSER into IIS Worker Process Group. 

7.f Click OK. 

8 Configure the identity of the DefaultAppPool to run under the ASPNET account.  This is 
required because SQL scripts are run to give permissions to ASPNET users to access the 
databases.  The permissions are given according to the Access Control List (ACL) for each 
folder listed below.  To check or change the ACL settings, do the following: 

8.a In Windows Explorer, navigate to each folder in the list. 

8.b Right-click the folder and select Properties. 

8.c In the Properties pane, select the Security tab.  The ACL checkboxes are in the lower 
section of the pane. 

ASPUSER Folder 

¶ Default Location: C:\Windows\TEMP 

¶ Access type should be: Full Control 

ASP .NET Dynamic Compilation Folder 

¶ Default Location: C:\WINDOWS\Microsoft.NET\Framework\v2.0\Temporary ASP.NET Files 

¶ Access type should be: Full Control 

ASP .NET installation folder 

¶ Default Location: C:\Windows\Microsoft.NET\Framework\v2.0.xxxx 

¶ Access type should be only: Read & Execute, List Folders Contents, Read 

9 Update the AzManStore keys in the Web.config files of the virtual directories: 
Microsoft.Ccf.Csr.WebServices.CcfInfrastructure  
Microsoft.Ccf.Csr.WebServices.AdminConsole and make sure they point to: 
C:\CCF\DemoData\AzManCCF.xml.   

Note: The actual Web service names for 

Microsoft.Ccf.Csr.WebServices.CcfInfrastructure and   

Microsoft.Ccf.Csr.WebServices.AdminConsole inside the configuration list are: 

Microsoft.Ccf/Csr.WebServices.Providers.CcfInfrastructure.Application and  
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Microsoft.Ccf/Csr.WebServices.Providers.AdminConsole.AgentWS respectively.     

9.a In the Admin Console, expand the configurations node and double-click the Web 
service. 

9.b In the Properties window, click the Build button 

9.c In the Build Configuration Value window, highlight the AzMan key name and click Edit. 

9.d In the Configuration Action window, the value for azManStore should be the 
location shown above. 

9.e Repeat the procedure for the other Web service. 

Note: Also make sure that the AzManCCF.xml file <InstallDir>\Program 

Files\Microsoft CCF 2008\Data\AzManCCF.xml is not set to read only as the Agent 

Desktop must read and write to this file. 

10 Update the authorization section in the Web.Config of Web services to authorize users who 
are in the CCF Domain (<allow roles="ccf\ccfusers" />), the gateway may need to be 
updated to authorize all the users (<allow users =ò*ò/>), or another more specific group. 

11 Install the file Microsoft.Ccf.Csr.WebServices.AdminConsole.Setup.msi 

12 Use the Admin Console MMC snap-in application and:  

12.a Add yourself as an Agent using the Agents node. 

12.b Update the Options to change the CtiType to 2 (to indicate TAPI to be used with 
Softphone Application) using the Settings -> General Settings node. 

12.c Update the Options to add a phone number for yourself using the Settings -> 
Phones node.   
For example, configure the phone as Jane (3331).  You can configure this phone number 
to any number as seen in the Softphone. 

12.d Configure workflows for yourself using the Workflows node. 

12.e Configure hosted applications for yourself using the Application Mappings node, 
in the file 
<RootFolder>\SourceCode\CSR\WebServices\CcfInfrastructureWebServices\Application.
asmx.cs and corresponding provider files, ApplicationProvider.cs & 
AzManApplicationProvider.cs.  Refer to the Configuring AzMan topic shown later in this 
section for further details. 

CCF provides a TAPI emulator for development and debug work, however, this tool is not for use 
in a production system and is designed for developer testing only. 

13 The Integrated Agent Desktop installer installs the TAPI emulator at the location  
<InstallDir>\Windows\System32. 

14 Open Phone and Modem Options from the Control Panel. 

15 Click the Advanced tab. 

16 Highlight the Emulator of TAPI service provider and Click Add. 
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3.2 Adding Hosted Applications 

To configure new applications, use the Admin Console application.  Refer to the CCF 2008 
Administration Guide for more information on the Admin Console. 

3.2.1 Server Side Configuration 

Application Table 

The Application table holds details of all the applications in CCF.  Configuration is as follows: 

1 Provide a unique integer value as the application ID. 

2 Provide a unique name for the application. 

3 Specify the type of application.  Possible values are 0, 1, and 2. 

¶ Type 0 identifies a Win Form based application.  It is derived from 
IScriptableHostedApp. 

¶ Type 1 identifies a Web application. 

¶ Type 2 identifies an external (typically Win32) application.  It is also derived from 
IScriptableHostedApp.  These applications will use some external assemblies like MS 
Word Interop assembly or will be Win32 applications. 

4 Initialize the hosted application using an XML string.  For each of the above types, the XML 
nodes will differ. 
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For type 0: 

The Initialization string should be in the XML format shown below: 

<initstring > 

  <assemblyInfo > 

    <URL> 

C: \ Program Files \ MicrosoftCCF2008 \ Source 

Code\ Microsoft.Ccf.Samples. Csr.AgentDesktop \ Microsoft.Ccf.Samples \ Csr \ C

urrentSessionControl \ bin \ Debug 

    </ URL> 

<type >Microsoft.Ccf.Sampl es.CurrentSessionControl.CurrentSessionControl

</ type > 

  </ assemblyInfo > 

  <global  > 

</ initstring > 

For type 1: 

The initialization string should be in the XML format shown below: 

<initstring > 

  <homePage>http://www.microsoft.com </ homePage> 

</ initstring > 

Note: The homepage node specifies the URL to which the Web browser control will 

navigate. 

For type 2: 

The initialization string should be in the XML format shown below: 

<initstring > 

  <interopAssembly > 

    <URL> 

      C: \ Office XP  

      PIAs \ Microsoft.Office.I nterop.Word.dll  

    </ URL> 

    <type >Microsoft.Office.Interop.Word.ApplicationClass </ type > 

  </ interopAssembly > 

</ initstring > 

Note: The interopAssembly node refers to the location from where the external assembly 

could be fetched.  The Type node refers to the Type (.NET key word) the assembly is 

queried for.  To configure Win32 applications, refer to the External Applications and 

Integration topic found later in this section. 

5 Provide an integer value in the SortOrder column indicating the position of this hosted 
application in a list of hosted applications available to the Agent. 
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3.2.2 UI Configuration 

There are two options for the overall look and feel of the Agent Desktop: 

Desktop.cs 

This option provides a UI with immobile components snapped into one whole. 

To run:  

1 Ensure that Desktop.cs is included in the Microsoft.Ccf.Samples.Csr.AgentDesktop project 
by right clicking and choosing Include In Project. 

2 Ensure that DesktopToolbar.cs is excluded from the Visual Studio project by right clicking 
DesktopToolbar.cs and choosing ñExclude From Projectò. 

DesktopToolbar.cs 

This option provides a UI with mobile, floating components. 

To run: 

1 Ensure that DesktopToolbar.cs is included in the Microsoft.Ccf.Samples.Csr.AgentDesktop 
project by right clicking and choosing Include In Project. 

2 Ensure that Desktop.cs is excluded from the Visual Studio project by right clicking 
DesktopToolbar.cs and choosing Exclude From Project. 

The UI configuration of the hosted application is done by adding the following XML code to the 
application initialization. 

<initstring > 

  <displayGroup >MainPanel </ displayGroup > 

  <optimumSize  x=" 800"  y=" 600" />  

  <minimumSize  x=" 640"  y=" 480" />  

</ initstring > 

The <displayGroup>  node refers to the panel to which this hosted application is to be added.  

The value of displayGroup can be any one of the following: 

¶ MainPanel: Add the hosted application to lower right of the Agent Desktop. 

¶ SessionExplorerPanel: Add the hosted application to the panel containing Session 
Explorer user control.  The hosted application will appear as a tab page in the left top of the 
Agent Desktop along with the Session Explorer user control. 

¶ CurrentSessionPanel: Add the hosted application to the panel containing Current Session 
Hosted control.  The hosted application will appear in the right top of the Agent Desktop. 

¶ WorkFlowPanel: Add the hosted application to the panel containing Workflow user control.  
The hosted application will appear as a tab page in the lower left of the Agent Desktop along 
with the Workflow user control. 

¶ Floating: This causes the hosted application to be hosted in a new form outside the Agent 
Desktop.  The hosted application appears as a separate item in the task bar. 

¶ HiddenPanel: The hidden panel allows hosted applications that do not have a visual 
component (e.g. CTI hosted control) to be run in CCF. 

The optimumSize  node refers to the Optimum size in which the application should be displayed.  

This will determine the best size for the application when the application is hosted in a container 
object.  Here X denotes the Width and Y denotes the Height. 

The minimumSize  is no longer used. 
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Action Table 

The Action table stores the actions that may be used on various hosted applications.  A hosted 
application should have at least one action configured in this table.  To map actions with hosted 
applications, do the following: 

1 Provide an integer value as the Action ID for a hosted application.  The Action ID for the 
application should be unique. 

2 Provide an Application ID for this Action. 

3 Provide a unique name for this Action. 

4 Initialize the Action of the hosted application using an XML string. 

For Application type -1 (Disabled):  This is used to disable an application without deleting it 
from the database. 

For Application type 0 (Windows Control): The initialization string should be in the XML format 
shown below: 

<ActionInit></ActionInit>  

Note: As of now, there are no actions configured for application type 0. 

For type 1 (Web Application): The initialization string should be in the XML format shown below: 

<ActionInit > 

  <Verb >GET</ Verb > 

  <Url >http://www.nextel.com/cgi - bin/localMarketMap.cgi </ Url > 

  <QueryString >zip=%ZipCode </ QueryString > 

</ ActionInit > 

Note: The Verb node refers to the HTTP GET method.  The URL node refers to the URL 

on which the method specified in the Verb node is invoked.  The QueryString node refers 

to the value to be obtained from the customerôs context in the Agent Desktop. 

For type 2 (External Application): The initialization string should be in the XML format shown 
below: 

<ActionInit > 

<Script >http://ccfiis/ ContactCenterClientDeployment/scripts/scripttest.

js </ Script > 

</ ActionInit > 

Note: The Script node refers to the URL of the script that has to be invoked as part of this 

action.  To configure actions for Win32 applications, refer to the External Applications and 

Integration topic found later in this section.  

If an action with ActionID 1 is not present, there will be a message box stating that the 

default action is not there and the next action with lowest ActionID is performed. 

 

3.2.3 Creating or adding an Action 

To create or add an action for a hosted application, do the following: 

1 In the Admin Console open the list of hosted applications. 

2 Click on the desired application to highlight it. 
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3 On the Menu Bar click Action, then Properties. 

4 In the Properties window, click the Actions tab and then the Add button. 

5 Type in the name of the action and the initialization string.  Click Build. 

6 Type in the values for the URL to which the action is directed.  

7 Type a query string.  This becomes part of the URL. 

8 Specify the GET or POST method. 

9 Specify a script (if any) that runs upon doing this action. 

10 Check the Focusé checkbox to allow the application to be in focus after initialization. 

11 Click Apply to build the string.  If you wish to make any changes, you may do so then click 
the Apply button again to set the changes. 

12 Click OK. 

13 In the Action window, click OK. 

3.3 Configuring Hosted Applications for Auto Sign-On 

This section explains how to configure hosted applications for the Auto Sign-on feature. 

If an application is to be Auto signed in, we first need to have the Agentôs credentials for the 
hosted application.  Then identify the controls on the hosted application where these Agentôs 
credentials are to be filled in. 

This configuration is two-fold.  One is to configure the ApplicationCredentials table of CCF and 
the second is to configure the ESSO store to have the Agentsô credentials for hosted applications. 

3.3.1 Configure the ApplicationCredentials table 

The ApplicationCredentials table holds details of all the login controls that are required to sign on 
to the hosted application. 

1 Provide a label for the login control in the LabelName column.  For example: 
Hotmail_Password for the password field control on the Hotmail page. 

2 Provide an ID for the Application to which this login field control corresponds. 

3 Provide details for the rest of the columns based on the hosted application type. 

For type 0: 

1 For Hosted Controls, set null for the AttributeIdentity and AttributeValue columns. 

2 In the case of Hosted Controls, provide the sequence of the desired login control in 
enumerated list of controls on the hosted control window.  Its value will be in a comma 
separated string format (Example: 1,3,2), which represents the hierarchy of the target 
control from the top level window. 

For type 1: 

1 In the case of Hosted Web Applications, provide the type of the attribute (name, ID, or 
value) in the AttributeIdentity column, which will be used to identify the login control on the 
login page of Web applications. 

2 In the case of Hosted Web applications, provide the value of the attribute (specified by 
AttributeIdentity) for the login control on the login page (HTML source of Login page) of 
Web applications in AttributeValue column. 
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3 In the case of Hosted Web applications, provide a sequence of control in the Sequence 
column when the control is identified by its ñvalueò or ñnameò attribute (which may or may 
not be unique on the login page HTML). 

For type 2: 

1 For External Applications, set null for AttributeIdentity and AttributeValue columns.   

2 In the case of External Applications, provide the sequence of the desired login control in an 
enumerated list of controls on External Applicationôs window.  Its value will be in a comma 
separated string format (Example: 1,3,2) which represents the hierarchy of the target 
control from the top level window. 

3 Provide the action to be performed on the login control in Action.  Its value can be Set or 
Click. 

Example: On the hotmail login page, Action column value will be ñSetò for login ID and password 
field controls and ñClickò for the Submit button. 

3.3.2 Configure the ESSO store 

1 On the CCFIIS machine, add the members of the CCFUsers user group to the SSO 
Affiliate Administrators and the SSO Administrators user group.  This is required for the 
Agents to access the ESSO DB to get their credentials via the AgentCredentials Web 
service. 

2 Two xml files must be formed on the CCFIIS machine before proceeding further. 

3 Copy the XML content shown below then save it to a file named App.xml at the location;  
C:\Program Files\Common Files\Enterprise Single Sign-On. 

<sso > 

  <application  name=" KnowledgeBase " > 

    <description >Knowledge base application used to demonstrate 

SSO</ description > 

    <contact >support@microsoft.com </ contact > 

    <appuserAccount >. \ SSO Affiliate Administrators </ appuserAccount > 

    <appAdminAccount >. \ SSO Administrators </ appAdminAccount > 

    <field  ordinal =" 0"  label =" User Id "  masked=" no"  />  

    <field  ordinal =" 1"  label =" Password "  masked=" no"  />  

    <flags  groupApp =" no"   allowLocalAccounts =" yes "  enableApp =" yes "  />  

  </ application > 

</ sso > 

4 Copy the XML content shown below and save it to a file named Appmapping.xml in the 
same folder, <InstallDrive>\Program Files\Common Files\Enterprise Single Sign-On. 

<sso > 

  <mapping > 

    <windowsDomain >ccf </ windowsDomain > 

    <wind owsUserId >demoagent1 </ windowsUserId > 

    <externalApplication >Knowledgebase </ externalApplication > 

    <externalUserId >csragent </ externalUserId > 

  </ mapping > 

</ sso > 

5 The App.xml file helps create an application in the ESSO DB.  Open the App.xml in an 
editor such as Notepad and modify it as per the steps below: 

5.a Set the application name as the name of the application as configured in the 
Application table of the CCFInfrastructure database. 
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5.b Set the description to a string describing the application. 

5.c Do not modify the content in the appuserAccount and the appAdminAccount.  These 
accounts specify the access permissions of the SSO DB. 

Note: The CCFusers user group should be added to the SSO Affiliate Administrators 

group.  This is required for the Agents to access the ESSO DB to get their credentials via 

the AgentCredentials Web service. 

5.d Do not modify the rest of the nodes in the xml file.  The modes User Id and 
Password denote the label names for the Agentôs credentials. 

6 The Appmapping.xml file helps in mapping the Agentôs credentials to the application 
created above.  Open Appmapping.xml in an editor and modify it as per the steps shown 
below: 

6.a Set the windowsDomain as the name of the domain of which the Agent is part. 

6.b Set the windowsUserID as the domain login name of the Agent. 

6.c Set the externalApplication as the application name provided in sub-step 5a  above. 

6.d Set the externalUserID as the User ID of the Agent for this application. 

7 Open a Command Prompt and change the current directory to C:\Program Files\Common 
Files\Enterprise Single Sign-On. 

8 Run the command ssomanage -createapps App.xml.  This will create the required 
application in ESSO. 

9 Run the command ssomanage ïcreatemappings Appmapping.xml.  This will map a 
login ID of the application to the Agent. 

10 Run the command ssomanage ïsetcredentials <domain>\<LoginName> 
<ApplicationName>.  Here, replace the domain with the domain name given in sub-step 6a  
above.  Replace the LoginName with the domain login name given in sub-step 6b above 
(windowsUserID).  Replace the ApplicationName with the application name given in sub-
step 6c above (externalApplication).  On running the command, there will be a prompt to 
enter the password, enter the password of the Agent and press Enter.  The password for 
this KnowledgeBase application is csragent. 

11 Now a login ID and password for the hosted application is mapped to an Agent. 

12 Repeat the steps 2 to 10 for each hosted application and for each Agent. 
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3.3.3 Configure the ESSO store for MCH Application 

This operation requires that the ESSO store be configured as in the procedure in the previous 
section. 

Name the Login Application as Multi Channel Login and enable the Requires Auto Sign-On as 
shown in the image below.  (If the name is changed, the code would have to be changed, so it is 
advisable to keep the name Multi Channel Login) 
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Set the Credentials field as in the image given below: 

Note: Verify the sequence in the Login.cs file, default sequence is as follows: 

 

 

 

Also the file App.xml needs to be modified as follows: 

<sso > 

  <applicati on name=" Multi Channel  Login " > 

    <description >Application to Login MCH Application </ description > 

    <contact >support@microsoft.com </ contact > 

    <appuserAccount >. \ SSO Affiliate Administrators </ appuserAccount > 

    <appAdminAccount >. \ SSO Administrators </ appAdminAccount > 

    <field  ordinal =" 0"  label =" ApplicationID "  masked=" no"  />  

    <field  ordinal =" 1"  label =" Password "  masked=" no"  />  

    <field  ordinal =" 2"  label =" Place "  masked=" no"  />  

    <flags  groupApp =" no"   allowLocalAccounts =" yes "  enableApp =" yes "  />  

  </ application > 

</ sso > 
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The file Appmapping.xml in the folder, <InstallDrive>\Program Files\Common Files\Enterprise 
Single Sign-On needs to be modified as follows: 

<sso > 

  <mapping > 

    <windowsDomain >ccf </ windowsDomain > 

    <windowsUserId >demoagent1 </ wind owsUserId > 

    <externalApplication >Multi Channel  Login </ externalApplication > 

    <externalUserId >csragent </ externalUserId > 

  </ mapping > 

</ sso > 

The Appmapping.xml file helps in mapping the Agentôs credentials to the application created 
above.  Open Appmapping.xml in an editor and modify it as per the steps shown below: 

¶ Set the windowsDomain as the name of the domain of which the Agent is part. 

¶ Set the windowsUserID as the domain login name of the Agent. 

¶ Set the externalApplication as the application name provided in sub-step 5a  above. 

¶ Set the externalUserID as the User ID of the Agent for this application. 
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3.4 Configure a Hosted Application for Application 
Isolation 

It is possible that a hosted application may have a behavior that has a bad effect on the Agent 
Desktop.  For that reason, it is wise to isolate the Agent Desktop from the applications.  The 
hosted application can be configured by making changes to the Application Initialization string in 
the Application table. 

The initialization string should be like the XML format shown below: 

<initstring > 

  <appIsolation > 

    <HasContainer >yes </ HasContainer > 

    <ContainerType >process </ ContainerType > 

    <ContainerPrefix >test </ ContainerPrefix > 

  </ appIsolation > 

  <assemblyInfo > 

<URL>http://ccfiis/ContactCenterClie ntDeployment/bin/HostedWindowsContr

ol.dll </ URL> 

    <type >Microsoft.NSP.ContactCenter.HostedScriptableControl </ type > 

  </ assemblyInfo > 

</ initstring > 

The HasContainer  node specifies whether the hosted application has to be isolated or not.  

The possible values for this node are ñyesò or ñnoò. 

The ContainerType  node specifies the type of isolation for the hosted application.  The 

possible values for this node are appdomain or process.  If appdomain is specified, the hosted 
application runs on a separate thread on a separate AppDomain.  If ñprocessò is specified, the 
hosted application runs in a separate process. 

The ContainerPrefix  node specifies the prefix used to generate a unique identifier for each 

container. 

Note: Application Isolation is not implemented for external applications, i.e.  Applications 

of type 2. 

3.4.1 Troubleshooting 

Problem: 

The following error could occur:  

Error: Auto Sign-On failed for external application 

System.Web.Services.Protocols.SoapException: Server was unable to process request. ---> 
System.UnauthorizedAccessException: Access is denied. 

at SSOLookupLib.SSOLookupClass.GetCredentials(String bstrApplicationName, Int32 lFlags, 
String& pbstrExternalUserName) éé 

Solution: 

1 Go to IIS and find Microsoft.Ccf.Csr.WebServices.AgentCredentials Web service 

2 Right click Microsoft.Ccf.Csr.WebServices.AgentCredentials and choose Properties. 

3 Go to the Directory Security tab and click Edit button under the ñAuthentication and access 
controlò section 

4 In the Authentication Methods window make sure that the Enable anonymous access 
checkbox is not checked. 
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3.5 Dynamic Applications 

From a lifecycle management perspective, CCF currently has two types of hosted apps, global 
hosted apps and session-scoped, or non-global hosted apps.  A global hosted app is launched 
either at the startup of agent desktop, or at the start of a workflow upon which the global hosted 
app is tagged as dependent.  It is usually recycled when the agent desktop is terminated.  A non-
global hosted app is launched either at session start up or at the start of a workflow if the app is 
tagged as workflow dependent.  It is usually recycled at the end of the session.   

CCF 2008 introduces a 3rd category of hosted apps in dynamic hosted applications.  These allow 
an agent to dynamically launch or close a hosted application on-demand, via the UI or 
programmatically in code.  A dynamic application can either be global or non-global. 

Global dynamic application are loaded at the first request and hidden thereafter and can be 
requested at anytime (such as during a global session, normal session, or workflow). 

Non-global dynamic applications can only be loaded once a session has started and each 
session will use a different instance of the application. 

If a dynamic application is part of a workflow and has not started when the workflow starts, then 
the workflow will start the application and the application will stop when the workflow is complete. 

The integration of applications into CCF is managed by Microsoft Application Integration 
Framework (AIF).  AIF puts some constraints on actions that are performed by applications when 
they start up.  This behavior is not strictly limited to dynamic applications but all hosted 
applications. 

¶ For Web applications that are global, no initial, default action runs. 

¶ For Web applications that are non-global, the default initial action runs once. 

¶ For Windows applications that are global, the default initial action runs once. 

¶ For Windows applications that are non-global, the default initial action runs twice.  Even 
though the action runs twice, there is only one instance of the application.  The effect is the 
same as that of global applications. 

3.5.1 Configuring Dynamic Applications 

Any hosted application can be made dynamic by checking the Application is dynamic checkbox 
in the initialization string build window.  To access the initialization string: 

1 Open the Admin Console and expand the machine node. 

2 Open the Hosted Applications node 

3 Double-click the hosted app that you wish to make dynamic to open the properties page. 

4 On the properties page, click the Buildé button. 

5 In the General section of the build window, check the appropriate check boxes.  See the 
explanation below. 

6 Click OK.  The application will be dynamic. 

7 Close the Properties window. 

Configuring the application manually can be accomplished in the XML code.  This is what the 
Build tool does via the steps above.  To configure an application to be a dynamic add the 
following XML code to the application initialization string in the Application table.  It can be set 

anywhere within the <initstring >.... </ initstring > tag set. 

 
<dynamic > 

  <show>true </ show> 
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  <closed >false </ closed > 

</ dynamic > 

The <show> node is used to indicate whether a dynamic application is to be shown in the UI.  

The Agent can then launch it from the icon in the UI.  When a request is made to the 
ApplicationHost to get the list of dynamic application names to display, only dynamic applications 
with the show node set to true will be returned.  Setting the node to false allows launching  
dynamic applications in code, but they will not show in the UI and cannot be launched from there. 

Setting the <closed > node to true indicates that the dynamic application is ñclosed offò and once 

started cannot be closed dynamically via the UI or programmatically in code.  The application is 
closed at the end of the session for session scoped non-global apps and when agent desktop is 
terminated for global apps. 

3.6 WCF and Web Service Configuration  

In CCF 2008, .asmx Web services have been migrated to Windows Communication Foundation 
(WCF) and carry a .svc file type suffix.  The programming model of WCF, called 
System.ServiceModel, is built on the Microsoft .NET Framework and simplifies development of 
connected systems.  Although the CCF Installer handles the installation of Web services and 
WCF, some configuration is required.  

 

3.6.1 WCF Service Configuration Options 

In order to host the new WCF Web Services in IIS, Anonymous access must be enabled for 
the .svc files in those Web services: 

1 Click Start -> All Programs -> Administrative Tools -> Internet Information Services 
(IIS) Manager. 

2 On the IIS page, expand the <Svr> node. 

3 Expand the Web Sites node. 

4 Expand the Default Web Sites node 

5 Select the desired virtual directory 

6 Right click on the .svc file and select Properties 

7 Select the File Security tab 

8 Under Authentication and access control click Edit 

9 Check the Enable anonymous access checkbox 

10 Reset the IIS machine. 

 

3.6.2 WCF Security 

Windows Communication Foundation offers many different security options including transfer 
security, access control, and auditing.  Each security options perform different functions including 
integrity, confidentiality, authentication, and authorization.  All these security options are 
configurable via configuration files.  Depending on your implementation, you can choose and 
configure the security option that is appropriate for your needs.  You can find out more about 
WCF security here http://msdn2.microsoft.com/en-us/library/ms732362.aspx. 

For demo purposes CCF is shipped with the following WCF security configurations: 

http://msdn2.microsoft.com/en-us/netframework/aa663324.aspx
http://msdn2.microsoft.com/en-us/netframework/aa663324.aspx
http://msdn2.microsoft.com/en-us/netframework/aa663324.aspx
http://msdn2.microsoft.com/en-us/library/ms732362.aspx
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¶ In order to make use of URL/File base authorization and because WCF web services are 
hosted in IIS, ASP.NET compatibility mode must be enabled. 

o In the Web.config files of each of the Web services this mode is enabled by way 
of the XML statement as shown in the example below: 

<serviceHostingEnvironment  aspNetCompatibilityEnabled =" true "  />  

¶ Binding is set to basicHttpBinding - A binding that is suitable for communicating with WS-
Basic Profile conformant Web Services, for example, ASMX-based services.  This binding 
uses HTTP as the transport and Text/XML as the default message encoding. 

¶ Security mode is set to TransportCredentialsOnly ï this mode does not provide message 
integrity and confidentiality.  It provides only HTTP-based client authentication. 

¶ ClientCredentialType is set to Windows ï Windows Authentication  

3.7 Configuring CCF to use HTTPS (SSL) on IIS 6.0 

The operation of CCF is dependent upon interaction with Web services.  A typical CCF 
environment would be built around servers, clients, and networks, all of which are secure.  
Another level of security can be added to Web sites themselves with SSL. 

Note: To use SSL successfully, the SI will need to obtain a valid, server certificate which 

must be signed by a trusted root authority.  

If obtaining a certificate is not feasible, you may use a certificate self test tool called selfssl.exe.  
This tool is part of the IIS 6.0 Resource Kit available from Microsoft.  This tool can be used to 
generate a self-signed, trusted certificate.  The tool uses its own command line and is opened 
from Start -> All Programs -> IIS Resources. The syntax is: 

 selfssl /T /N:CN=CCFIIS /v:9999 

¶ /T - adds the self-signed certificate to the Trusted Certificates list.  This will tell the local 
browser to trust the self-signed certificate 

¶ /N:CN= - Specifies the common name of the certificate. The computer name is used if not 
specified.  In the example given, the machine name is CCFIIS, yours may be different. 

¶ /K:key size - Specifies the key length. Default is 1024. 

¶ /V: - specifies the length of the validity, in days, of the certificate. Default is 7 days. 

¶ /S:site id - specifies the id of the site. Default is 1 (Default Site). 

¶ /P:port - specifies the SSL port. Default is 443. 

¶ /Q - quiet mode. You will not be prompted when SSL settings are overwritten. 

In the example CCFIIS is the IIS server name.  Use the name of the machine in your particular 
instance. 

Note: For security reasons, the use of self-signed certificates is not recommended for 

any purpose other than testing or development. 

3.7.1 Using the Certificates MMC snap-in  

You can verify the certificates on any server by examining the list of certificates.  To open the 
certificate list: 

1 Click Start, then Run, and type in mmc and click Enter. 

2 In the mmc console, click on the File menu and click Add/Remove Snap-in. 

http://www.microsoft.com/downloads/details.aspx?FamilyID=56FC92EE-A71A-4C73-B628-ADE629C89499&displaylang=en


 

Microsoft Customer Care Framework 2008 -- Development Guide 
33 

3 In the Add/Remove Snap-in window, click on the Add button. 

4 In the Snap-in list, select Certificates and click Add. 

5 In the Certificates Snap-in window, select Computer account, click Next. 

6 In the Select Computer window, select Local computer or Another computer and click 
Finish.  This adds the Certificates snap-in to the list.  Close the window. 

7 In the Add/Remove snap-in window, click OK.  This adds the Certificates snap-in to the 
mmc console. 

8 Expand the Certificates node to see the different types of certificates. 

The self-trusted certificate created with the selfssl tool will be visible in the Certificates folder in 
the Personal and the Trusted Root Certification Authorities folders.  It will be named whatever 
the value of /N:CN is. 

3.7.2 Configuring CCF Client Applications 

This procedure is for configuring the CCF client applications (Agent Desktop and mmc.exe) to 
use HTTPS using specific binding names in the endpoints mentioned here.   

To convert http-based client applications to https secured applications, use the following 
procedure: 

1 Open the AgentDesktop.exe.config file in an editor.  It is found in the AgentDesktop folder, 
normally in the location <InstallDir>:\Program Files\Microsoft CCF 2008\AgentDesktop 

2 In the <client >...</ clie nt > section of the file, there is a list of endpoints.  In each 

<endpoint  address , change the http to https. 

3 In each endpoint, change the binding reference from Binding1 to Binding2. For example: 

<bindingConfiguration =" Binding 2".   These binding references are pre-defined in 

CCF. 

Note: If the Agent Desktop is running anonymously, use the binding name 

Binding2Anon and change the client credential type to 

clientCredentialType =" None" . 

4 In the address in the <appSettings >...</ appSettings > section change http to 

https. 
5 Use the same procedure to alter the endpoint addresses and binding references in the 

mmc.exe.config file.  This file is in the Administrative Tools folder in the location 
<InstallDir>\Program Files\Microsoft CCF 2008\ and in <installDir>\WINDOWS\System32 

Note: The mmc.exe.config file has the IIS server name pre-configured as CCFIIS.  For 

example: endpoint  address =" http://ccfiis/.  If the IIS server name is 

different, change this value in all of the endpoints in the client section. 

 

Note: The CCF installers place the mmc.exe.config file in the System32 and 

Administrative Tools folders.  If, at any time, CCF is re-installed or updated, the 

mmc.exe.config file must be copied from the Administrative Tools folder to the System32 

folder.   

 

Note: When Admin Console prompts for a hostname and port, it will override the port 

number for every web service endpoint when a port number is provided.  This will cause 
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problems if there is a mix of http-based and https-based Web services.  The 

recommendation is to always leave the port field blank unless strictly dictated by 

circumstances. 

3.7.3 Configuring CCF Web services 

This procedure is used to configure the CCF Web services to use HTTPS using specific binding 
names in the endpoints mentioned here.   

To convert http-based web services to https secured Web services, use the following procedure: 

1 Open the wwwroot folder in the location <InstallDir>:\Inetpub\.  In that folder are the 
folders for the CCF Web services. 

2 Double-click the folder for the desired Web service. 

3 Double-click the web.config file.  This should open the folder in an editor. 

4 In the <client >...</ client > and <services >...</ services > sections of the 

file, there is a list of endpoints.  In each <endpoint  address , change the http to https. 

5 In the address in the <appSettings >...</ appSettings > section change http to 

https. 
6 In each endpoint, change the binding reference from Binding1 to Binding2. For example: 

<bindingConfiguration =" Binding2 ".   These binding references are pre-defined in 

CCF. 

Note: If the AgentLoginManager Web service is to run anonymously, use the binding 

name Binding2Anon and change the client credential type to 

clientCredentialType =" None" . 

7 Save the web.config file. 
8 Repeat the procedure to alter the endpoint addresses and binding references in any other 

Web services that are to be run securely. 
9 The Web service URLs in the database can be altered through the Admin Console. 

9.a Open the CCF Admin Console.  Expand the <machineName> node.  
9.b Expand the Settings, then the Configurations nodes. 
9.c   Double-click the URL you wish to change to open the Properties window. 
9.d In the Value section of the properties window, change http to https and click OK. 
9.e Repeat the procedure for all desired names of type URL. 

It is not necessary to change all Web services to https.  Only the Web services that require the 
level of security need to be changed.  However, the changes must be made on the servers and 
those changes must be made on the client machines. 

Note: Any binding configurations associated with Multi Channel configurations must be 

set to Binding1.  The Multi Channel Web services do not support HTTPS. 

3.7.4 Configuring Empty Endpoint URLs 

There may be endpoints in the AgentDesktop.exe.config file that have no endpoint address and 
consequently no URL to change.  An example is shown below. 

<! --  address set by config entry: 

name=Microsoft_Ccf_Csr_Core_ContextWebServices_ContextWebServices,type=

URL -- > 

      <endpoint  address =""  binding =" basicHttpBinding "  

bindingConfiguration =" Binding1 "  

contract =" Microsoft.Ccf.Csr.ContextWebServices.Cont extWebServices "  />  
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To configure these endpoints for https, change the bindingConfiguration to Binding2 and save the 
file.  The addresses, themselves must be changed in the Admin Console.   

To change the Web service addresses use the following procedure: 

1  Open the CCF Admin Console 

2 Expand the Settings node, then the Configurations node.  The Web services are listed with 
a type of URL 

3 Right-click the desired Web service and click Properties.  In the configuration file, all of the 
empty endpoint URLs have an accompanying comment showing their name and type in 
the Admin Console configurations node. 

4 In the Value section of the Properties window, change http to https in the address. 

5 Click OK.  Use the same procedure for any other URLs that need to be configured.  The 
Admin Console may now be closed. 

 

3.8 Creating a New Agent 

This section explains how to add a new Agent and configure rights and permissions for the Agent. 

It is recommended that you carry out this activity using Admin Console Application.  The 
information listed below is provided for developer's information. 

To configure new Agents using Admin Console Application, refer to the Administration Guide. 

Assumptions: 

The user knows how to use SQL Management Studio or SQL Management Studio. 

The user has access permissions to modify the CCFInfrastructure databases on the SQL server 
of CCFSQL. 

3.8.1 Adding a new Agent: 

1 Create a new domain user (For example, DemoAgent1, DemoAgent 2 etc) for the new 
Agent. 

2 Add the newly created domain user to the existing CCFUsers domain user group. 

3 Make an entry for this user in the CCFUser table of the CCFInfrastructure database. 

3.9 Configuring Agent Information in SQL Server 

3.9.1 Server Side Configuration 

A CCF administrator can configure Agent information.  It includes the following: 

¶ Configuring CCFUser table 

¶ Configuring Agentôs phone number. 

3.9.2 Configuring CCFUser table for the Agent 

1 Connect to the SQL server CCFSQL using the SQL Management Studio. 

2 From the CCFInfrastructure database, open the CCFUser table. 

3 Check if Users like DemoAgent1, DemoAgent2, and DemoAgent3 are already configured 
in the CCF User table.  If not, execute the following steps to configure DemoAgent1 and 
DemoAgent2 and DemoAgent3. 
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4 Enter the next ordinal number in the AgentId column, CCF\DemoAgent1 in the 
DomainUser column, Ann Marie in the FirstName column, Walsh in the LastName column, 
1 in the Type column and DemoAgent1.JPG in the Picture column; tab out of the 
Supervisor column to have a NULL value in the Supervisor column.  This completes the 
DemoAgent1 user details. 

5 Repeat the previous steps for DemoAgent2 by entering the next ordinal number as AgentId, 
óCCF\DemoAgent2ô as DomainUser, óDavidô as FirstName, óDorsonô as the LastName, 1 as 
Type and óDemoAgent2.jpgô as Picture; tab out of the Supervisor column to have a NULL 
value in the Supervisor column. 

6 Close the CCFUser table. 
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3.10 Configuring Agentôs Phone Number 

The phone number can be configured in either of the following two ways: 

Using the Options table 

1 Connect to the SQL server CCFSQL using the SQL Management Studio. 

2 From the CCFInfrastructure database, open the Options table. 

3 Add an entry in the Options table to map the Agentôs machine with a phone number.  For 
instance if a PC with the machine name of ñDemoAgent1ò is used by DemoAgent1, update 
the Options table to have an entry with Name as ñPhoneAt_DemoAgent1ò and the value as 
the Agentôs phone number (like ann marie walsh (2351212)). 

Using the Config file 

Each instance of the Agent Desktop carries one config file. 

1 Open the AgentDesktop.exe.config on the Agentôs machine at the location: 
<installdrive>\Program Filles\Microsoft CCF2008\Agent Desktop. 

2 In the <appSettings > </ appSettings > section, add a key specifying the Agentôs 

phone number.  The example shown is how the key should appear in the XML.    

<add  key =" agentNumber "  value =" ann marie walsh (2351212) " />  

Note: It is possible that the agent phone number can be added by both methods above.  

However, in that case, the config file overrides the Options table.  

The Agentôs phone number should be the one as seen by the actual telephony hardware 

component in the real time scenario.  For example, in the Softphone application, the 

phone numbers are entered as a name followed by a number such as: Jane (3331)ò. 

3.11 Configuring AzMan  

Authorization of the Agent to use Hosted Applications can be done either using AzMan or using 
the ApplicationGroup table.  Refer to the ñHosted Applications Authorization Configurationò 
section for further details. 

AzMan can be configured using either an XML file or Active Directory as the store type.  You can 
follow one of the methods mentioned in the steps shown below. 

3.11.1 Configuring AzMan on CCFIIS Using XML  

You can configure AzMan on the CCFIIS machine using an XML file as the store type. 

1 Click Start then Run. 

2 Type mmc in the text box and press Enter. 

3 Click File -> Add/Remove Snap-in. 

4 Click Add . 

5 Select Authorization Manager from the new window and click Add. 

6 Close the new window. 

7 Click OK. 

8 Right-click Authorization Manager and click Open Authorization Store. 

9 Choose XML file as the store type. 
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10 Browse to C:\CCF\DemoData\AzManCCF.XML. 

11 Expand the CCF application. 

12 Click Groups. 

13 Right-click Agent and click Properties. 

14 Click the Members tab. 

15 Click the Add Windows Users and Groups button. 

16 Type CCFUsers in the text box click Enter the object names to select box and click OK. 

17 Click a hosted application scope, for example Microsoft Web. 

18 Click Role Assignments. 

19 Right-click AgentUsers. 

20 Click the Assign Application groups. 

21 Select Agent and click OK. 

22 Repeat steps 18 to 22 to configure hosted applications for other agents. 

To add a new hosted application in Authorization Manager using XML Store: 

1 Right-click CCF. 

2 Click New Scope. 

3 Enter the hosted application name in the Name box.  The name should be the same as the 
name in the Application table. 

4 Click the newly created hosted application scope. 

5 Right-click Role Assignments. 

6 Click Assign Roles. 

7 Select AgentUsers and click OK. 

8 Repeat steps 1 to 7 to configure the other hosted applications. 

3.11.2 Configuring AzMan on CCFIIS Using Active Directory  

You can configure AzMan on CCFIIS using Active Directory as the store type.  Make sure the 
Domain is Windows 2003 Functional Level.  If not, raise it to the Domain Functional Level. 

Refer to Windows Server 2003 Help Documentation for more details. 

To configure AzMan using Active Directory: 

1 Click Start then Run. 

2 Type mmc in the text box and press Enter. 

3 Click File>Add/Remove Snap-in. 

4 Click Add. 

5 Select Authorization Manager from the new window and click Add. 

6 Close the new window. 

7 Click OK. 

8 Right-click Authorization Manager and click Options. 

9 Select Development mode and click OK. 
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10 Right-click Authorization Manager and click New Authorization Store. 

11 Select Active Directory. 

12 In the name Store, change Program Data to AzManCCF and click OK. 

13 Right-click AzManCCF and click Properties. 

14 Select the Security tab. 

15 Select Reader from the Authorization Manager user role list box. 

16 Click Add. 

17 Type the domain user, ASPUSER, in the new window and click OK. 

18 Click OK in the parent window. 

19 Right-click AzManCCF and click New Application. 

20 In the New Application dialog box, type the name as CCF1.0 and click OK. 

21 Right-click Groups under CCF and click New Application Group. 

22 In the New Application Group dialog box, type the name as Agent and click OK. 

23 Right-click Agent and click Properties. 

24 In the Agent Properties dialog box, select the Members tab. 

25 Click Add Windows Users and Groups. 

26 Type CCFUsers in the text box and enter the object names to select box and click OK. 

27 Click OK. 

28 Open Definitions under the CCF application. 

29 Right-click Role Definitions and click New Role Definition. 

30 In the Role Definition dialog box, type the name as AgentUsers and click OK. 

31 Right-click CCF. 

32 Click New Scope. 

33 Type the hosted application name in the Name box.  The name should be the same as the 
name in the Application table. 

34 Click the newly created hosted application scope. 

35 Right-click Role Assignments and click Assign Roles. 

36 Select AgentUsers and click OK. 

37 Right-click AgentUsers and click Assign Application Groups. 

38 Select Agent and click OK. 

39 Open the Web.config file in the Microsoft.Ccf.Csr.WebServices.CcfInfrastructure virtual 
directory  

40 Update the AzManStore keyôs value="msldap://CN=AzManCCF,DC=CCF" where CCF is 
the domain name. 

41 Repeat the steps from 31 to 40 to configure a newly hosted application. 

To add a new hosted application in Authorization Manager using Active Directory: 

1 Right-click CCF. 

2 Click New Scope. 
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3 Type the hosted application name in the Name box.  The name should be same as the 
name in the Application table. 

4 Click the newly created hosted application scope. 

5 Right-click Role Assignments and click Assign Roles. 

6 Select AgentUsers and click OK. 

7 Right-click AgentUsers and click Assign Application Groups. 

8 Select Agent and click OK. 

9 Open the Web.config file in the Microsoft.Ccf.Csr.WebServices.CcfInfrastructure virtual 
directory 

10 Update the AzManStore keyôs value to: value="msldap://CN=AzManCCF,DC=CCF" where 
CCF is the domain name. 

3.11.3 Setting Access Permissions for Applications 

In the above-described configurations, the access permissions for applications are given to the 
CCFUsers user group, and they will have access to the configured applications.  Access to the 
applications can be restricted to specific users by the following settings. 

To set access permissions for applications: 

1 Click a hosted application. 

2 Click Role Assignments. 

3 Right-click the assigned role, AgentUsers. 

4 Click Assign Windows Users and Groups. 

5 Type the Windows user name of the Agent to whom you want to give access permissions. 

6 Click OK. 

Refer to the Authorization Manager documentation for more details. 

The AzMan file has been pre-configured so that the entire preconfigured applications are listed in 
the AzmanCCF.xml.  This is done so that to the preconfigured hosted applications can be set by 
adding windows logins namely DemoAgent1, DemoAgent2, and DemoAgent3 logins to the Agent 
group.  

Note: These logins cannot be preconfigured as SIDs (Security descriptors) because 

Windows Login is added to the AzmanCCF.xml, which will be unique for each system 

and login.  The Agent role has to be added to each of the hosted applications to enable 

the applications for those agents.  Use the Admin Console Application to do this. 

3.12 Configuring the ApplicationGroup table  

The authorization of Agent to Hosted Applications can be done either using AzMan or using the 
ApplicationGroup table.  Please refer to the ñHosted Applications Authorization Configurationò 
section for further details. 

Setting access permissions in the ApplicationGroup table  

The access permissions of the hosted applications can be granted to Agents via the Windows 
groups they belong to.  For example, supervisors may have access to certain hosted applications 
and normal agents may have access to other applications. 

To set access permissions for applications: 
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1 Connect to the SQL server CCFSQL using the SQL Management Studio. 

2 From the CcfInfrastructure database, open the ApplicationGroup table. 

3 In the ApplicationID column, type the ID of the application to which permission has to be 
granted.  You can get this from the Application table. 

4 In the GroupName column, type the windows group name to which permission has to be 
granted.  All the members of this windows group will be able to access the application 
specified in the ApplicationID column. 

3.13 Skills 

Some Agents will have expertise in some skills and may not be specialized in others.  You can 
configure CCF to link particular agents with certain skills using the Admin Console Application.  
The information shown below is provided for developer's information. 

To configure skills using Admin Console Application, refer to the Administration Guide. 

Assumptions 

The user knows how to use SQL Management Studio. 

The user has access permissions to modify the  CcfInfrastructure database on SQL server of 
CCFSQL. 

Server Side Configuration 

To add a skill: 

1 Connect to the SQL server CCFSQL using the SQL Management Studio. 

2 From the  table, open the Skill table. 

3 Type an ID for the skill in the appropriate row under the SkillId column. 

4 Type a name for the skill in the appropriate row under the Name column. 

To map Skills to an Agent: 

1 From the CcfInfrastructure database, open the SkillMap table. 

2 In the SkillId column, type a SkillId from the Skill table.  In the UserID column, type the 
Agentôs ID who has expertise in this skill. 

3 For mapping more skills to this agent or other agents, repeat the steps 2 and 3 as needed. 

3.13.1 Troubleshooting 

Problem Cause Solution 

The Assistance menu on the 
Agent Desktop does not have 
any sub menu items. 

There are no skills 
configured in the DB. 

Configure skills in the DB as 
explained above. 

3.14 Channels 

Channels are the means of communication agents can use to communicate with each other. 

It is recommended that this activity be carried out using the Admin Console Application.  The 
information shown below is provided for developer's information. 

To configure channels using the Admin Console Application, refer to the CCF  Administration 
Guide document. 
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Assumptions 

The user knows how to use SQL Management Studio. 

The user has access permissions to modify the CcfInfrastructure database on SQL server of 
CCFSQL. 

Server Side Configuration 

To add a Channel: 

1 Connect to the SQL server CCFSQL using the SQL Management Studio. 

2 From the CcfInfrastructure database, open the Channel table. 

3 Type an ID for the Channel in the appropriate row under the ChannelID column. 

4 Type a name for the Channel in the appropriate row under the Name column. 

To map Channels to an Agent: 

1 From the CcfInfrastructure database, open the ChannelMap table. 

2 In the UserID column, type the ID for the agent who will be using the channel. 

3 In the ChannelID column, type the ID of the channel that will be used for communication. 

4 For mapping more Channels to this agent or other agents, repeat the steps 2 and 3. 

Note: As of the time of the publication of this document, only the Remote Assistance 

channel is supported. 

3.14.1 Troubleshooting 

Problem Cause Solution 

In the Assistance menu, select 
Billing, A message box 
saying ñUnable to provide 
assistance in Billingò is 
displayed. 

There are no Agents 
configured on the Remote 
Assistance channel to 
provide assistance on 
ñBillingò . 

Map Agents to channels and 
Agents to Skills in the appropriate 
tables as explained above. 

3.15 Agent Presence States 

Agent presence states are the various states which will be listed in the Agent Desktopôs Status 
Menu.  Presence state will be used to display the current state of an agent to other Agents on 
Remote Assistance Instant Messenger. 

It is recommended that this activity be carried out using Admin Console Application.  The 
information shown below is provided for developer's information. 

To edit Presence States using the Admin Console Application, refer to the Administration Guide. 

Assumptions 

The user knows how to use SQL Management Studio. 

The user has access permissions to modify the CcfInfrastructure database on SQL server of 
CCFSQL. 

Server Side Configuration 

To Modify Agent Presence States: 

1 Connect to the SQL server CCFSQL using the SQL Management Studio. 
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2 From the CcfInfrastructure database, open the PresenceState table. 

3 Modify a presence state in the appropriate row under the Name column.  This will appear 
in the Agent Desktopôs Status menu. 

3.16 Workflow 

Workflow is a series of steps designed to help an Agent serve a customer better.  Each step in a 
workflow corresponds to a hosted application.  There are two types of workflows: 

¶ Forced workflow 

¶ Non-forced workflow 

In a Forced workflow, the Agent has to follow the steps in a sequential order.  In a Non-Forced 
workflow, there is no restriction for the order of execution. 

You can configure the steps and access the permissions for a workflow using the Admin Console 
application.  The information shown below is provided for developers. 

To configure Workflows using the Admin Console Application, refer to the CCF Administration 
Guide. 

In a workflow, applications can be designated as Global or Non Global.  In Application Table ï Init 

String, applying the tag <global/>  to an application signifies that the application is Global.  If no 

tag is applied the application is designated as Non-Global. 

In addition, in Application Table ï Init String, applying the tag <workflow/> to an application 
signifies that the application is tagged and is only visible when a workflow requires it.  The 

application is said to be dependent on the workflow.  Applications without the <workflow/>  tag 

are always visible and are said to be independent of the workflow.  This rule applies to both 
global and non-global applications.  

The workflow items are not marked as completed, even though they may be, if the agent selects 
them via the tabs or the Session Explorer, regardless of whether they are part of the workflow.  If 
this were the case, the agent would have to take extra steps and the workflow would slow down 
the agent.  Thus, the workflow drives the applications - the applications do not drive the workflow. 

Note: A workflow will apply to a session with a customer only if that customer has a 

customer ID value.  If a workflow is applied to New Customer, that is a customer without 

an ID value, the workflow activities will not function until an ID is assigned. 

The new implementation of human workflow uses the Windows Workflow Foundation.  The step 
has been represented as an activity called CcfWorkflowStep.  The CcfWorkflowStep activity 
defines the step as focusing on the specified hosted application.  Next, if there is an action it is 
executed.  

The human workflow is started by clicking on the desired workflow step of the hosted Workflow 
Control.  Next, a FireRequestAction() method calls to the CustomerWorkflowManager with a 
human workflow action and parameters describing the hosted application in question (the hosted 
application in question corresponds to the step user clicked on).  The CustomerWorkflowManager 
then handles the action including hooking into and setting up the CcfWorkflowStep.
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Workflow Use Cases 

 

Case 1.  Agent Desktop starts 

 

 

The Agent logs in to the system and starts the Integrated Agent Desktop (IAD).  

If there is a workflow (e.g. a workflow engine), only global, hosted applications permitted to this 
agent and independent of the workflow will be loaded and displayed. 

If there is no workflow, all global applications are loaded and displayed, regardless of whether 
they are part of a workflow. 

 

 

Case 2.  Session starts 

 

 

 

 

When a session starts, 
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If there is a workflow (e.g. a workflow engine), then all non-global, hosted applications permitted 
to this agent and that are independent of the workflow will be loaded and made visible in addition 
to those already loaded in case 1. 

If there is no workflow, all non-global hosted applications permitted to this agent will be loaded 
and made visible in addition to those already loaded in use case 1. 

Case 3.  Workflow starts 

 

When an agent selects and starts a workflow, all global and non-global applications that are 
dependent on the workflow are now loaded and made visible in addition to those already loaded 
in use case 1 and 2. 

 

Case 4.  Workflow Done 

 

When an agent is finished with a workflow and clicks ñDoneò, regardless of whether the workflow 
is forced or non-forced, all global and non-global applications that are dependent on the workflow 
are closed and removed from the session explorer.  The non-global applications that are 
independent of the workflow are still visible and are only closed when the session is closed.  The 
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global applications that are independent of the workflow are still visible and are only closed when 
the Agent Desktop is closed. 

 When an agent is NOT finished with the workflow and clicks Done: 

If the workflow is forced, a message box will appear stating: ñPlease complete all steps to finish 
the workflowò. 

If the workflow is non-forced, all global and non-global applications that are dependent of the 
workflow are closed and removed from the session explorer.  The non-global applications that are 
independent of the workflow are still visible and are only closed when the session is closed.  The 
global applications that are independent of the workflow are still visible and are only closed when 
the Agent Desktop is closed. 
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5. Workflow Cancel 

 

 

When an agent cancels a workflow, all global and non-global applications that are dependent on 
the workflow are closed and removed from the session explorer.  The non-global applications that 
are independent of the workflow are still visible and are only closed when the session is closed.  
The global applications that are independent of the workflow are still visible and are only closed 
when the Agent Desktop is closed. 
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6. Session Closed 

 

When a session is closed  

If there is a workflow (e.g. workflow engine) then:  

If workflow is forced, a message box displays: ñYou have to complete workflow steps before 
closing sessionò. 

If workflow is not forced, only the tagged global applications and all the non-global (tagged and 
untagged) applications are closed. 

If there is no workflow, only the non-global applications, regardless of being tagged or untagged, 
are closed.  All the global applications, tagged and untagged, will stay visible until desktop is 
closed. 

 

Definition: 

Workflow engine ï is the mechanism that manages the series of steps of a workflow.  It provides 
the user interface (UI) and the various functionalities that can be performed on a workflow such 
as start, finish, next, previous, and cancel. 

A workflow engine can be configured to be used or not by setting the WorkflowExists switch in 
the Options table of the CCFInfrastructure database.  WorkflowExists can also be configured 
using the Admin Console under the Settings -> General Settings node. 

 

For the following examples, it is assumed that the user is familiar with the SQL Management 
Studio and that the user has access permissions to modify the CcfInfrastructure database on the 
SQL server of CCFSQL. 

3.16.1  Installing Work Flow Hosted Control 

To add a Hosted Control, do the following:  

This procedure can also be performed using the AzMan snap-in 

1 Open the Admin Console. 

2 Expand the root node CCF in the left hand tree. 

3 Click the Hosted Application Node. 

4 Right click the List View pane and click New Hosted Application.  The Add New Hosted 
Application Wizard window will be displayed. 
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5 On the welcome screen, click Next.  The Add New Hosted Application Wizard (Step 1 of 3) 
screen will appear. 

6 Enter Work Flow for the name of the hosted application. 

7 Select Windows Control from the drop down list box for the type of the hosted application. 

8 Click Build to build the Initialization String.  The Build Application Initialization String 
window will appear. 

9 In the URL text box, enter the file path to the file: 
Microsoft.Ccf.Samples.WorkFlowControl.dll.  

10 Enter Microsoft.Ccf.Samples.WorkFlowControl.WorkFlowControl in the Type text box. 

11 Enter WorkFlowPanel for the Display Group text box. 

12 Select Not Isolated from the Isolation Level drop down list. 

13 Check the Application is global check box. 

14 Click OK 

15 Make sure Requires Auto Sign-On and Disable Application checkboxes are not 
checked. 

16 Click Next.  The Add New Hosted Application Wizard (Step 3 or 3) will appear. 

17 Click Add... to add an action.  The Action window will appear. 

18 Enter default for the action name 

19 Click Buildé  The Build Action Initialization Stringé window will appear. 

20 Click New 

21 Click OK 

22 Click OK on the Action window 

23 Click Apply 

24 Click OK 

To create Application Mapping for the hosted Control: 

1 Expand the root node CCF in the left hand tree. 

2 Click the Application Mapping node. 

3 Right click on the blank area in the list view pane and click Mapping Wizard.  The 
Application Mapping Wizard will be displayed. 

4 Click Next.  The Application Mapping Wizard (step 1 of 3) will be displayed. 

5 From the Application drop-down list, select Work Flow. 

6 Click Next.  The Application Mapping Wizard (step 2 of 3) will be displayed. 

7 To grant access to available roles, select one or more roles in the Available list box and 
click >Assign. 

8 Click Next.  The Application Mapping Wizard (step 3 of 3) will be displayed.  The Role drop 
down list will show the name or names of the roles from step 2. 

9 Select a role from the drop down. 

10 Select one or more groups from the Available list box. 

11 Click Assign. 
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12 Click Finish. 

Server Side Configuration 

All the workflow configurations need to be executed on the server side by a CCF administrator. 

The following steps assume that the existing workflow for the pre-configured, hosted applications 
has already been configured during installation.  In addition, the WorkflowsMaster, 
WorkflowStepsMaster, and AgentWorkflowACL have already been updated for the pre-configured 
hosted applications during installation. 

3.16.2 Configuring a new workflow 

Connect to the SQL server CCFSQL using the SQL Management Studio. 

1 From the CcfInfrastructure table, open the WorkflowsMaster table. 

2 In the Name column, provide the name of the workflow.  This name will be displayed as 
part of the Agentôs current Workflowôs list box 

3 Provide a description of the workflow in the Description column. 

4 Set the value in the IsForcedWorkflow column to:  Non-forced workflow set the value to 
False, Forced workflow set the value to True. 

5 Click Run.  Note the value in the WorkflowID column for the newly entered row. 

To complete the configuration, you will need to add steps into the WorkflowStepsMaster table. 

To add steps into the WorkflowStepsMaster table do the following: 

1 From the CcfInfrastructure table, open the Application table. 

2 Choose an application that is to be the first step of the newly added workflow.  Note the 
value in the ApplicationID column for that application. 

3 From the CcfInfrastructure table, open the WorkflowStepsMaster table. 

4 In the WorkflowID column, type the workflow ID that you obtained when configuring the 
workflow. 

5 Provide a name to this workflow step by editing the Name column.  This name will be listed 
in the Agentôs Current workflow list box. 

6 Provide a description of this step in the Description column. 

7 To initiate an action on corresponding applications for this step, provide the name of the 
action in the WorkflowAction column. 

8 Modify the ApplicationID column with the application ID you obtained in Step 2. 

3.16.3 To map steps to a workflow: 

1 From the CcfInfrastructure table, open the WorkflowStepMap table. 

2 In the WorkflowID column, type in the workflow ID.  Workflow steps need to be associated 
with this ID. 

3 In the StepID column, provide the step, which needs to be mapped to this workflow. 

4 To make this the first step in the workflow, enter 1 in the Sequence column. 

5 For configuring more steps to this workflow, repeat the steps from 3 to 4 by providing 
appropriate sequence numbers. 
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3.16.4 Configuring Access Rights for Agents 

Agents need access rights to view workflows.  This section describes how to configure the access 
permissions for Agents. 

To configure access rights: 

1 Connect to the SQL server named CCFSQL using the SQL Management Studio. 

2 From the CcfInfrastructure database, open the CCFUser table. 

3 Choose the Agent to whom access right are to be given.  Make a note of the value in the 
UserID column of the user. 

4 From the CcfInfrastructure table, open the WorkflowsMaster table. 

5 Choose the workflow to which you want to give access.  Make a note of the value in the 
WorkflowID column of the workflow. 

6 From the CcfInfrastructure table, open the AgentWorkflowACL table. 

7 Modify the AgentID column with the user ID obtained in Step 3 and update the WorkflowID 
column with the Workflow ID obtained in Step 5. 
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3.16.5 Troubleshooting 

Problem Cause Solution 

The Current Workflow control 
of Agent Desktop is always 
disabled and I donôt see 
anything there. 

The Agent does not have 
access to any of the 
workflows. 

 

An administrator can configure 
access rights to the Agent. 

 

When I click an item in the 
Current Workflow list view, I 
get an error message saying, 
ñYou do not have access to this 
hosted application.  Please 
contact the administrator.ò  
Why do I get this error? 

The Agent has access to the 
workflow but does not have 
access to the application 
corresponding to the selected 
step in the workflow. 

 

An administrator can configure 
access rights to the hosted 
applications of each of the steps of 
the workflow.  You need to 
configure Authorization Manager for 
this. 

I get an error message, 
ñPending workflow for this 
session is not available.  
Please contact the 
administrator.ò  Why do I get 
this error? 

 

The Agent does not have 
access to the workflow 
corresponding to the workflow 
ID of the pending workflow.  
The administrator would have 
removed the access right to 
this Agent. 

An administrator can configure 
access rights to the Agent. 
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3.17 Mapping a Workflow to Groups 

In addition to assigning a workflow to an agent, workflows can be assigned to groups of users 
and not just agents.  Workflow by group mapping is a feature of CCF that allows a user to assign 
multiple groups of users to a workflow.  Those users can be agents, administrators, or any 
collection of users of CCF.  Assigning a group to a workflow means giving the group permission 
to run that particular workflow.  

3.17.1 Operation of AzMan XML Store 

 

Data flow and Operation using AzMan XML Store 
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3.17.2 Setting the Mapping Store 

CCF uses role-based authorization that operates through the Authorization Manager MMC snap-
in.  The mapping of the relationship between groups and agents is stored either in the AzMan 
XML store or in the database and accessed through active Directory.  You can change whether to 
use the Active Directory or to use the AzMan XML store.  To set this decision, do the following: 

1 In Windows Explorer go to the folder <OSDrive>\Windows\system32 

2 Open the file mmc.exe.config in an editor such as Notepad.  

3 Find the section tagged <appSettings> é </appSettings>.  Using Visual Studio as the 
editor, the section would appear as below: 

<appSettings > 

  <add  key =" UseAzman"  value =" true "  />  

  <add key =" ConfigurationArea "  value =" AgentDesktop " />  

</ appSettings > 

4 Check the value of the UseAzMan key.  If set to true, AzMan will be the store for the 
mapping data.  If set to false, Active Directory will store the data in the CCF database.  

3.17.3 Using the AzMan XML store 

Machine: IIS server 

User: Administrator 

In order to use the AzMan XML as the mapping data store, the workflow providers 
Microsoft.Ccf/Csr.WebServices.Providers.AdminConsole.WorkflowWS and 
Microsoft.Ccf/Csr.WebServices.Providers.AdminConsole.WorkflowMappingWS must be 
configured to use it.  Use the procedure below to configure them: 

1 Open the CCF Admin Console.  

2 Expand the machine node and expand the Settings node.  

3 Expand the Configurations node. 

4 Double-click the WorkflowWS Web service to open the properties window. 

Note: You can make it easier to find these Web services by clicking on the Area column 

which sorts the entire list by area.  The area in question is AdminConsoleWS. 

5 In the Properties window, click Buildé to open the Build Configuration Value window. 

6 In the Provider section of the Build Configuration Value window, Click on the 
AzMAnWorkflowWSProvider value and click Edit to open the Configuration Action 
window. 
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7  In the Attributes  section, the following attributes should be displayed: 

type Microsoft.Ccf.Csr.WebServices.Providers.AdminConsole.AzManWor

kflowWSProvider,Microsoft.Ccf.Csr.WebServices.Providers 

connectionString Server=CCFSQL;Integrated 

Security=true;Database=CcfInfrastructure;Pooling=true; 

azManStore msxml://<InstallDrive>\CCF\DemoData\AzManCCF.xml 

8 Follow the same procedure for the Web service 
Microsoft.Ccf/Csr.WebServices.Providers.AdminConsole.WorkflowMappingWS.  The 
attributes should be as follows: 

type Microsoft.Ccf.Csr.WebServices.Providers.AdminConsole.AzManWor

kflowMappingWSProvider,Microsoft.Ccf.Csr.WebServices.Providers 

connectionString Server=CCFSQL;Integrated 

Security=true;Database=CcfInfrastructure;Pooling=true; 

azManStore msxml://<InstallDrive>\CCF\DemoData\AzManCCF.xml 

 

3.17.4 Using the Active Directory Store 

Storing the mapping data in the database by way of Active Directory is an alternative method to 
using AzMan XML.  But, like it, the Active Directory providers must be configured ï the difference 
being that the provider uses the Active Directory and the database rather than AzMan. 

Type Microsoft.Ccf.Csr.WebServices.Providers.AdminConsole.SqlWorkflo

wWSProvider,Microsoft.Ccf.Csr.WebServices.Providers 

connectionString Server=CCFSQL;Integrated 

Security=true;Database=CcfInfrastructure;Pooling=true; 

In Active Directory, the mapping is handled by DBWorkflowMappingWS which has the following 
attributes: 

Type Microsoft.Ccf.Csr.WebServices.Providers.AdminConsole.SqlDBWor

kflowMappingWSProvider,Microsoft.Ccf.Csr.WebServices.Providers 

connectionString Server=CCFSQL;Integrated 

Security=true;Database=CcfInfrastructure;Pooling=true; 

Note: After applying either of these configurations, to make sure that the new setup is 

applied, reset the IIS machine on which you were working.  
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3.17.5 Operation of Active Directory Store 

 

Data flow and Operation using Active Directory Database Store 

 

 


